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Welcome to the Country Vid Grid on-line Help window.
The following Help Topics are available for finding out more about Country Vid Grid.
Click on any topic below with an underline to go to that topic.

General:
      How to Play Country Vid Grid 

Country Vid Grid Screens:
     Main Screen 
      Level Screen 
      Custom Mode 

Scoring:
      Understanding Country Vid Grid Levels 
      Scoring & Saving the Game 

How to Use Country Vid Grid HELP 
Clicking on "How to Use Country Vid Grid HELP" above brings up a separate Help window that provides 
extensive information on how to get the most out of this Help window. Info about using Menu bar and 
Button bar commands is also covered.

To return to this window from any Help screen, click on the Contents button above.
To get out of this Help window and get back to the game, select Exit from the File menu.



How to Play Country Vid Grid
To return to the Help screen you were just in, click on the Back button above.

COUNTRY VID GRID GAME OVERVIEW
As you watch each video, the screen is divided into pieces that are all mixed up. You have to unscramble 
each video while it's playing and before the music ends. 

Country Vid Grid consists of five levels: Level 1 being the easiest, up through Level 5, the most difficult.    
While you can choose the videos in any order you like, the puzzle configurations are preset by Country 
Vid Grid and get progressively more difficult as you play. You must solve all the video puzzles in a level 
before advancing to the next level. Within a level, you may replay any video to try to beat your last best 
time. You are not penalized for repeating a video. You score points each time you solve a video -- the 
harder the puzzle configuration, the more points you get. In addition, you get bonus points based on how 
quickly you solve the video. The bonus points are not added to your score until the end of each level. Try 
to get the highest score by solving the most puzzles in the shortest times.

Also, you can choose one of three degrees of game difficulty in Country Vid Grid. When you install 
Country Vid Grid, or when you add a new player, you are asked to choose one of three degrees of game 
difficulty: Easy As Pie, Middle of the Road or Tough As Nails.

There is also a Custom Mode for playing a single video at a time. Custom Mode allows you to select 
which video to play and to select the desired puzzle configuration. Custom Mode allows two or more 
players to compete at solving the same video puzzle. No points are scored in Custom Mode; the object is 
simply to get the best time.

COUNTRY VID GRID BASIC INSTRUCTIONS
IMPORTANT: To get optimal performance while playing Country Vid Grid, we strongly recommend that 
you do not run any other programs or applications in the background. Please close all other applications. 
If you experience any difficulties running Country Vid Grid, exit Windows, then load Windows again (type 
WIN at the C:\ prompt) and run Country Vid Grid before opening any other applications. You may have to 
remove icons from your Start-Up group in the Windows Program Manager.

Also, to view the videos at their largest video size, set your monitor resolution to 640 x 480 pixels. We 
also strongly reccommend that you set your computer's color setting to 256 colors.

Step One.  Select Player. If the player's name in the lower left corner of the screen is your name, you can
skip this step. If not, click on the Change Player button located in the lower left corner of the Main Screen 
to select or add your name and choose one of the three degrees of game difficulty: Easy as Pie, Middle of
the Road or Tough as Nails.

IMPORTANT: To save games, scores and best times, the correct player's name must be selected before 
playing.

Step Two.  Select a Video. Click on one of the "stills" in the Main Screen to "play" that video. These 
"stills" are actually "buttons" that you use to select a video. This will take you from the Main Screen to the 
Play Screen. Note: The "stills" are pictures taken from the videos and are "scrambled" until the respective 
video puzzle is "solved".

IMPORTANT: You can click on a "still" using the right mouse button to see information about the video 
and the recording artist.

Step Three.  Play the Video. When you are ready, click the "Play" button in the upper right hand corner of
the Play Screen. The video and the timer will start. Use your mouse to unscramble the pieces. See the 



section entitled "Using the Mouse to Unscramble the Pieces" that follows this section for further 
instructions. If the Video finishes before you do, the timer will read "Time's Up!". If you solve the video 
puzzle, the timer will display your time and a green neon border around the Video Window will light. 

IMPORTANT: You can continue watching the video or get on with the game by either clicking Reset or 
Main (the Main button will flash slowly to prompt you to return to the Main screen).

You now have a number of choices:

          -    You can try to solve the same video again: click Reset, then click Play when you are ready.
          -    You can play a different video: click Main, then go back to Step Two of these instructions.
          -    You can change players: click Main, then click Change Player.
          -    You can try Custom Mode: click Main, then click Custom Mode.
          -    You can exit Country Vid Grid: click Quit.

If you want to "give up" in the middle of solving a puzzle, click on either Reset to start over or Solve (so 
you can at least watch the rest of the video). In either case, you get no points (or penalties).

That's it. All the rest are just details you can pick up as you play Country Vid Grid. Please refer to the 
following more detailed instructions if you have any questions or run into any problems.

USING THE MOUSE TO UNSCRAMBLE THE PIECES
There are three basic mouse moves:

Drag and Drop the Pieces.    You can move a piece to any position. Move the mouse to position the 
arrow cursor over a piece. Use the left mouse button to click and drag the selected piece to a new 
location and release the left mouse button. You don't have drag the piece into an exact position, as it will 
automatically snap to the closet grid position. This move works in any puzzle configuration involving either
Drag and Drop or Perfection puzzle movements (see the section below "How Videos are Scrambled" for 
more details about puzzle configurations).
Slide the Pieces.    You can move a piece to an adjacent empty piece. Use the left mouse button to click 
on a piece that is next to an empty piece. The piece will "slide" into the empty piece's position. This move 
works in any puzzle configuration involving either Slider or Random Corners puzzle movements.
Flip the Pieces.    You can flip an individual piece from top to bottom. Use the right mouse button to click 
on a piece and "flip" it. This move works in any puzzle configuration involving Inverted Pieces.

HOW THE VIDEOS ARE SCRAMBLED
Country Vid Grid puzzles start easy, with four right-side-up pieces that can be moved by simply dragging 
them around the Video Window. However, as you progress through the game, you will encounter more 
difficult puzzles which are the result of changing three sets of puzzle attributes: Puzzle Size, Puzzle 
Movement and Video Orientation.

PUZZLE SIZE
There are 25 puzzle sizes:

4 piece, 6, 8, 9, 10, 12, 15, 16, 18, 20, 24, and 25 pieces.    Videos can be scrambled into 4 pieces (2 
pieces by 2 pieces), 6 pieces (3 pieces by 2 pieces), 8 pieces (4 pieces by 2 pieces) and so on.

Spaghetti.    This puzzle size is 10 pieces arranged horizontally.



Progressive 4-6, 4-6-9, 4-9-12, 6-9, 6-12, 6-12-15, 9-15, 9-16, 9-16-20, 12-15, 16-Spaghetti, and Ultra 
(6-9-Spaghetti-12-16).    These are the Progressive puzzle sizes. A Progressive 4-6 puzzle starts with 4 
pieces that, when initially solved, re-scrambles into 6 pieces. All Progressive puzzles work the same way: 
Progressive 4-6-9 (4 to 6 to 9 pieces) and Progressive 4-9-12 (4 to 9 to 12 pieces).

PUZZLE MOVEMENT
There are four types of puzzle movement:

Drag and Drop.    You click on a piece with the mouse and drag it anywhere in the Video Window and 
drop it there. The piece that was in that spot will swap with the moved piece. Drag and Drop mode allows 
you to swap the positions of two pieces.
Slider.    You can only move a piece to the blank piece next to it. Simply click on a piece next to the blank 
piece. The piece will switch with the blank piece. You can only move a piece that is next to the blank 
piece. You can only move one position up, down, left or right. Diagonal moves can't happen. In Slider, the 
piece that belongs in the bottom right hand corner is always the blank piece.
Perfection.    This is the same as Drag and Drop except that the video re-scrambles if a piece is dropped 
in the wrong position. However, if either of the swapped pieces ends up in its correct position, the video 
will not re-scramble. Also, if you drag a piece, but return it to the position from which you took it before 
dropping it anywhere, this is not considered a move and the video will not re-scramble.
Random Corners.    This is the same as Slider, except the blank piece is not necessarily from the bottom,
right corner: it may be from any corner.

VIDEO ORIENTATION
There are three types of video orientation:

Normal. The video plays in the normal fashion (right side up).
Upside Down. The video plays upside down (and so all the pieces are upside down). You cannot flip the 
pieces.
Inverted Pieces. The video plays right side up, but some of the individual pieces may be upside down. 
You can flip any piece using the right mouse button.

For more Help with Country Vid Grid, click on the Contents button above. This will take you to the 
Contents window which lists additional topics you can select for more information.
To get out of this Help window and get back to the game, select Exit from the File menu.



Main Screen
Country Vid Grid's Main Screen is the "home base" that you use to select videos, change, add or delete 
players, choose Custom Mode and more.

Click on any function below - outlined in green -    to learn more about that function.

For more Help with Country Vid Grid, click on the Contents button above. This will take you to the 
Contents window which lists additional topics you can select for more information.
To get out of this Help window and get back to the game, select Exit from the File menu.



Level Screen
Clicking a video button on the Main Screen brings you to the Level Screen where you "play" the videos.

Click on any function below - outlined in green -    to learn more about that function.

For more Help with Country Vid Grid, click on the Contents button above. This will take you to the 
Contents window which lists additional topics you can select for more information.
To get out of this Help window and get back to the game, select Exit from the File menu.



Custom Mode
Clicking the Custom Mode button on the Main screen puts Country Vid Grid into Custom Mode. Custom 
Mode is where you play against other players or the clock for Best Times. Custom Mode is a play mode in
Country Vid Grid that allows you to determine the puzzle configuration.

Click on any function below - outlined in green -    to learn more about that function.

For more Help with Country Vid Grid, click on the Contents button above. This will take you to the 
Contents window which lists additional topics you can select for more information.
To get out of this Help window and get back to the game, select Exit from the File menu.



Understanding Country Vid Grid Levels
Country Vid Grid consists of five levels: Level 1 being the easiest, up through Level 5, the most difficult. 
While you can choose the videos in any order you like, the puzzle configurations are preset by Country 
Vid Grid and get progressively more difficult as you play. You must solve all the video puzzles in a Level 
before advancing to the next Level. Within a Level, you may replay any video to try to beat your last best 
time. You are not penalized for repeating a video. You score points each time you solve a video -- the 
harder the puzzle configuration, the more points you get. In addition, you get bonus points based on how 
quickly you solve the video. The bonus points are not added to your score until the end of each Level. Try 
to get the highest score by solving the most puzzles in the shortest times.

Completing a Level. If you successfully solve all puzzles in a Level, Country Vid Grid will immediately 
switch back to the Main Screen as soon as the last video is solved. Each video button will "unwrap" and 
show you your Bonus points scored for that puzzle. While all of this is happening, watch the score total 
display in the lower right-hand corner of the screen: your Bonus points will be added to your Base points 
as the videos unwrap and the total "rolls up". As with solving an individual video, this running total is 
automatically saved to the current player's file on your hard drive. At the end of the score "roll up", 
Country Vid Grid displays the next Level screen.

For more Help with Country Vid Grid, click on the Contents button above. This will take you to the 
Contents window which lists additional topics you can select for more information.
To get out of this Help window and get back to the game, select Exit from the File menu.



Scoring & Saving the Game
Best Times. Clicking on this button displays a list of the 10 best times (with the names of the players) for 
the currently selected video in the currently selected puzzle configuration. The Best Times list includes all 
such best times from both Custom Mode and Levels Play.
Saving the Game. Country Vid Grid automatically saves solved video puzzles and earned points to a file 
on your hard drive. When the first player signs on, Country Vid Grid creates a file with that player's name 
and saves related information to that file whenever a puzzle is solved (which video, solve time, Level, 
round and points scored). This way, if you quit Country Vid Grid and come back to it later, all of your hard 
work will be saved and the game will pick up where you left off.
Base Points and Bonus Points. For each signed-on player, points will be awarded and displayed for 
each solved puzzle. The number of Base points awarded increases after each video is solved. Bonus 
points are also awarded based on how quickly the video is solved, but these points are not added to the 
player's score until the Level is completed. The number of bonus points per second increases after each 
Level is completed.

For more Help with Country Vid Grid, click on the Contents button above. This will take you to the 
Contents window which lists additional topics you can select for more information.
To get out of this Help window and get back to the game, select Exit from the File menu.



How to Use Country Vid Grid HELP
Clicking this the Help button on any screen opens the Help window. The Help window is context sensitive.
If you click the Help button from the Main Screen, help for the Main Screen will be displayed. If you click 
the Help button from the Level Screen, help for the Level Screen will be displayed.
Once the Help window is open, you can scroll through the window and view all the Help information for 
Country Vid Grid. The Help window will provide you with general and specific Help on playing Country Vid
Grid. Point to any function outlined in green and click once with the mouse.
A pop-up window will appear that will give you information about that function. To get out of the pop-up 
window, click again with the mouse or press a key on your computer keyboard.

A comprehensive help screen that describes how to use this Help window can be called up by clicking on 
the Help menu above and selecting the How to Use Help item. How to Use Help lists numerous topics 
that you can select that will teach you specific Help window techniques including Help Basics.
Below the Menu bar is a Button bar that will assist you in getting around Country Vid Grid Help quickly. To 
learn how these buttons work, click on the Help menu above and select the How to Use Help item. At the
very bottom of the window is a topic called Help Buttons that tells you how to use Country Vid Grid Help 
command buttons.



Video Buttons
Here you will see the video buttons in their scrambled state as miniaturized still 
pictures of the real videos. To choose a video, click once on the still picture from 
that video with the mouse (these miniature video pictures are actually "video 
buttons" that you use to select a video). Still pictures that are scrambled indicate 
that the particular video has not been solved by the current player in the current 
level. The manner in which the still pictures are scrambled indicates the puzzle 
configuration for the upcoming round. Stills that are not scrambled are framed in 
a bright neon green to show that they have been solved by the current player in 
the current level.
Clicking on a video button with the left mouse button takes the game out of the 
Main Screen and into the Play Screen. The Play Screen is where you attempt to 
solve the video puzzle in the shortest time for points. The puzzle type is preset by
Country Vid Grid.
Clicking on a video button with the right mouse button will display a window with 
artist, song and video credits.
For complete details on how to use the Play Screen, see Chapter 3 in the 
Country Vid Grid Owner's Manual.

Click once with the mouse button or press a key to continue...



Screen Title
The name of the artist and the song title are displayed here at the top of the 
screen.

Click once with the mouse button or press a key to continue...



Main Screen Title
The Main Screen title display shows the current Level of the game plus the 
current Degree of Game Difficulty for the current Player.

Click once with the mouse button or press a key to continue...



Custom Mode button
This takes Country Vid Grid out of the Main Screen and into Custom Mode. In 
Custom Mode, you select which video puzzle you want to solve and you 
customize the puzzle configuration (puzzle size, puzzle movement and video 
orientation).
For more information, see the Help window for Custom Mode.
For complete details on how to use Custom Mode, see Chapter 4 in the Country
Vid Grid Owner's Manual.

Click once with the mouse button or press a key to continue...



Change Player button
Country Vid Grid allows you to compete against other players. Use this button to 
open the Change Player dialog box.The Change Player dialog box adds new 
players to Country Vid Grid and allows you to delete players as needed. The 
name of the Current Player is displayed in the lower left-hand corner of the 
screen. Country Vid Grid will store up to 10 player's names and scores.

Click once with the mouse button or press a key to continue...



Main button
To select another video, change players or select the Custom Mode, you must 
return to the Main Screen by clicking this button.

Click once with the mouse button or press a key to continue...



Help button
Clicking the Help button on any screen opens the Help window. The Help window
is context sensitive which means if you click the Help button on the Main Screen, 
help for the Main Screen will be displayed.If you click the Help button on the Play 
Screen, help for the Play Screen will be displayed.
Once the Help window is open, you can access any Help topic for more 
information about Country Vid Grid by clicking the Contents button at the top of 
the window. This Help file will provide you with general and specific Help on 
playing Country Vid Grid. 
In addition, the Help windows for Main, Level and Custom Mode include a picture
of their screens with each function highlighted in green. Point to any function 
outlined in green and click once with the mouse. A pop-up window will appear 
that will give you information about that function. To get out of the pop-up window,
click again with the mouse or press a key on your computer's keyboard.

Click once with the mouse button or press a key to continue...



Quit button
Clicking this button exits Country Vid Grid. You will be asked to confirm your 
choice: click OK to exit, Cancel to return to the game.
When you exit Country Vid Grid, the status of your game, including your times 
and score will be saved automatically. If you quit Country Vid Grid and come back
to it later, all of your hard work will be saved and the game will resume where you
left off.

Click once with the mouse button or press a key to continue...



Player Display
The name of the current player is displayed in the lower left-hand corner of the 
Main Screen. All scoring -- solved puzzles, base points, bonus points and best 
times -- will be saved with this player's name. To change    to a different player, 
allow new players to sign-on, or to delete players from the game, click on the 
Change Player button. Anytime a new or different player is selected, that player's 
name will be displayed here.

Click once with the mouse button or press a key to continue...



Score Display
The accumulated score for the Current Player is displayed in the lower right-hand
corner of the Main Screen. The displayed score = the current running total of all 
earned base points + earned bonus points for previously completed Levels. 
Remember that bonus points are not added to your score until the current Level 
has been completed.

Click once with the mouse button or press a key to continue...



Video Window
The large window in the center of the screen is where the video puzzles play. 
When videos are not playing, this window displays the Country Vid Grid logo. For
a complete guide to playing Country Vid Grid, click on "How to Play Country Vid 
Grid" below:

Click here >    How to Play Country Vid Grid 

Click once with the mouse button or press a key to continue...



Solve button
Clicking on this button instantly solves the puzzle. The video will continue playing
until it reaches the end or the Stop button is pressed. We put this function in so 
that you can at least watch the video even if you are having trouble solving the 
puzzle. Clicking this button does not earn you a solved puzzle credit or any 
points!

Click once with the mouse button or press a key to continue...



Reset button
Clicking this button re-scrambles the video and starts it again from the beginning.
You can use Reset to give you a fresh start for any solved or partially solved 
video puzzle. Reset is useful if you want to try to beat your last time for a better 
score.

Click once with the mouse button or press a key to continue...



Timer Window
The small window above the video window is a clock timer that displays the 
elapsed time of the video -- in minutes and seconds -- and records the time it 
takes a player to solve the selected video. The Timer window starts at "0:00" and 
counts until the video ends. The numbers will be red until you click Play. During 
Play, the numbers will be green. If you solve the puzzle, the timer will freeze at 
the time you solved it and the numbers will be red again. If the video ends before 
it is solved, this window will display "Time's Up". Clicking Reset or Solve will 
reset the Timer.

Click once with the mouse button or press a key to continue...



Play/Pause/Resume/Stop button
Clicking this multi-state button repeatedly loops through several functions -- 
depending on the present state of the video puzzle.
Click Play when you are ready to start playing a video. The video will play and 
the timer will start. After you click Play, this button turns into a Pause button.
Clicking Pause allows you to stop the video anytime during playback. Pause also 
stops the timer -- you won't be penalized for pausing the puzzle, but the video 
screen will display the Country Vid Grid logo. You cannot move pieces unless the
video is playing. After you click Pause, this button turns into a Resume button.
Clicking Resume starts playback from the point where the video was stopped. 
This allows you to use the same button to pause and resume the video as often 
as you need.
The Stop function of this button only appears when the puzzle is solved. If you 
solve it manually or use the Solve button, the Pause function turns into a Stop 
function. After you click Stop, this button turns into a Play button and will loop 
between Play and Stop to allow you to view the video you have solved.

Click once with the mouse button or press a key to continue...



PUZZLE TYPE mini-window
The mini-window just to the left of the video screen displays the current puzzle's 
pre-set combinations of puzzle size (3x3, 4x4, 5x5, 6x6, 3-4, 3-4-5 and 3-4-5-6), 
puzzle movement (Drag and Drop, Slider, Perfection or Random Corners) and 
video orientation (Normal, Upside Down or Inverted Pieces).

Click once with the mouse button or press a key to continue...



TIME TO BEAT mini-window
Country Vid Grid allows players to re-play solved videos to get a better time. The 
Time to Beat mini-window records the current player's best time during the 
current game for the selected video. This window will be blank until the current 
player solves the selected video. Players may re-select a particular video at any 
time during a Level. If the player's time improves, the player's new time displays 
in the Time To Beat window and the bonus score will be increased upon 
completion of the Level. There is no penalty for getting a worse time (bonus 
points are awarded on the basis of the player's best time during the current 
game).
Note: Players who have completed Levels may not replay videos from a prior 
Level.

Click once with the mouse button or press a key to continue...



VOLUME control
You can adjust the audio volume by clicking on the volume arrows beneath the 
video window. The < button reduces the volume and the > button increases it. 
The green and yellow lights will show you the relative volume level. The last light 
segment is a red light that indicates maximum volume.

Click once with the mouse button or press a key to continue...



Select Video button
Clicking this button calls up a dialog box that allows you to select a video from a 
list of all the videos. Click the name of the video you want to play and click the 
OK button to load it.
After the video has been selected, use the next three buttons to set up the 
puzzle. Clicking these "multi-state" buttons repeatedly loops forward through all 
available choices. Holding down the shift key on the keyboard while clicking on 
the buttons with the mouse reverses through the order.

Click once with the mouse button or press a key to continue...



Puzzle Size button
Clicking this multi-state button repeatedly loops through the twenty-five puzzle 
sizes: thirteen puzzle sizes (4 piece, 6, 8, 9, 10, 12, 15, 16, 18, 20, 24, and 25 
pieces plus Spaghetti), plus twelve Progressive puzzle sizes (Progressive 4-6, 4-
6-9, 4-9-12, 6-9, 6-12, 6-12-15, 9-15, 9-16, 9-16-20, 12-15, 16-Spaghetti, and 
Ultra). Each time it is clicked, it will change to the next higher puzzle size.

Click once with the mouse button or press a key to continue...



Puzzle Movement button
Clicking this "multi-state" button repeatedly loops through the four puzzle 
movements: Drag and Drop, Slider, Perfection and Random Corners.

Drag and Drop: You click on a piece with the mouse and drag it anywhere in the 
Video Window and drop it there. The piece that was in that spot will swap with the
moved piece. Drag and Drop mode allows you to swap the positions of two 
pieces.
Slider: You can only move a piece to the blank piece next to it. Simply click on a 
piece next to the blank piece. The piece will switch with the blank piece. You can 
only move one position up, down, left or right. Diagonal moves can't happen. In 
Slider, the piece that belongs in the bottom right hand corner is always the blank 
piece.
Perfection: This is the same as Drag and Drop except that the video re-
scrambles if a piece is dropped in the wrong position. However, if either of the 
swapped pieces ends up in its correct position, the video will not re-scramble. 
Also, if you drag a piece, but return it to the position from which you took it before
dropping it anywhere, this is not considered a move and the video will not re-
scramble.
Random Corners: This is the same as Slider, except the blank piece is not 
necessarily from the bottom, right corner: it may be from any corner.

Click once with the mouse button or press a key to continue...



Video Orientation button
Clicking this "multi-state" button repeatedly loops through the three video 
orientations: Normal, Upside-Down and Inverted Pieces.

Normal: All pieces are scrambled right-side up.
Upside-Down: The entire puzzle is scrambled with all its pieces upside down.
Inverted Pieces: Country Vid Grid selects only a few pieces at random to be 
upside down (you have to figure out which ones they are). In either case, a piece 
that is upside down can be turned right side up by clicking on it with the right 
mouse button.

Click once with the mouse button or press a key to continue...



Best Times button
Clicking on this button displays a list of the 10 best times (with the names of the 
players) for the currently selected video in the currently selected puzzle 
configuration. The Best Times list includes all such best times from both Custom 
Mode and Levels Play.

Click once with the mouse button or press a key to continue...

 




